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1 Introduction 

Phontage is a multi-media communication tool using a PC based application to link the operation 

of an on-screen multi-button telephone with other communications-related PC applications.   

Phontage is a PC desktop application that interfaces with the user via the mouse and keyboard.  All 

the features of the LG-Ericsson IP Phone are available to the User.  In addition, a Phonebook 

database with links to the User‘s Personal Information Manager (PIM), provides pop-up windows 

for incoming Caller Identification (Caller ID).  Phontage users can employ the Phonebook to place 

calls as well as manage contact records.  An optional video interface delivers a visual interface for 

multi-party conferencing with 2 or 3 participants.  File Sharing allows multiple parties in a 

conference to view and manipulate files simultaneously.  Other special functions available to 

Phontage Users include: Appointment scheduling, SMS support, Email and Call recording. 

The Phontage application is available in three versions: Basic, Pro, and Deluxe.  The Basic version 

provides a standard feature set.  The Pro version supports the Basic feature set and additional 

features such as video, conferencing, etc.  The Deluxe version includes the Pro feature set and adds 

recording and collaboration functionality.  The following chart lists the features and functions of 

each version: 

NOTE—The Basic version is supported on all Call Servers (ipLDK/iPECS), the Pro version (Korea 

version only) is supported on all Call Servers except iPECS LIK, CM and MG, and the Deluxe 

version is supported on the iPECS LIK, CM and MG Systems.  

 

BASIC PRO (Korea only) DELUXE 

 All Basic Features Plus All Pro Features Plus 

Login with ID and Password Video Conference, 2-party Video Conference, 3-party 

Local/Remote Connection Mode Video Data On/Off Status Voice Mail Backup and Management  

*Flexible Buttons (24) Outlook Call Popup with Exchange Server  3rd party Conversation Recording 

Multi-language support *Conference Management Auto Call Recording including 3rd Party 

Call By Name Transparent Main Window function File Collaboration (Application Sharing) 

*User SMS (Short Message Service)  Call Assistance Window Internal Instant Messaging (IM-Chatting) 

Automatic Database Synchronization Favorite Contact Dialer *Flexible Buttons (48) 

Incoming Call Pop-up window Smart Recent Call List LDAP Search 

Hotkey Support  *Dynamic Group Call 

Database Import/Export   

User Connection Profiles   

Smart Tray Icon & Menu   

Quick Call Menu   

Simple Dial-pad pop-up   

Display Mode (Clock, Calendar)   

Phone Book Calling   
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BASIC PRO (Korea only) DELUXE 

 All Basic Features Plus All Pro Features Plus 

Phone Book Management    

Scheduled Dial and Notification    

User Call Log management   

E-mail with Outlook   

Simple Favorites Contact List   

*IP Bridge   

*Fixed Line SMS   

Audio Tuning Wizard   

*Preference Codec Selection   

Hook Switch Setting   

   

NOTE—Features marked with * may have minor differences depending on which System is used. 

 

1.1 User Programming and Limitations 

The Phontage generally operates in the same manner as a traditional LG-Ericsson IP Phone.  

There are, however, several user-programmable functions which are not supported due to 

differences in the platform (i.e., PC versus IP Phone).  The user-programmable functions not 

supported by Phontage include: 

 Station Answer mode – Does not support Intercom Call Announce; supports only 

Privacy for the Station Answer mode.  

 Station Ring Download – Can not download ring tone files from the System, 

however, the Phontage User can change ring tone files stored in the Phontage 

folder (refer to Section 5.1.2.9). 

 Audio source control – A single audio path is only available and thus cannot 

support the dual path (headset and speaker) controls available with the traditional 

LG-Ericsson IP Phone. 

 Call Recording – Only one call can be recorded at a time. Likewise, 3
rd

 Party record ing should 

not be used because it will have an effect on the recorded speech. 
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2 Installation and Setup 

Set-up of the Phontage is a four step process: 

1. Connect the PC to the Host System. 

2. Install the Phontage application on the User PC. 

3. Install system lock key. 

4. Login to complete System registration of the Phontage. 

Completing the login and registration process may require assistance from the system administrator 

to adjust any necessary settings.  The System will require a User ID and Password.  Also, for 

remote users, Phontage will require entry of the host System IP Address. 

Prior to installation, the PC and operating system should be verified for compatibility with the 

Phontage application.  Assure that the PC and Operating System (OS) comply with the minimum 

requirements of the following Sections 2.1 and 2.2. 

2.1 System Requirements 

The minimum requirements for the Phontage PC are described below. 

 Pentium 4 or compatible CPU 

 1 GHz clock speed or higher 

 256 Mbytes RAM  

 200 Mbytes of free hard-drive space 

 1024 x 768 resolution monitor 

 CD-ROM drive  

 Video/Web cam, only required for real-time video 

 USB Headset (Recommended) 

NOTE—Voice quality may differ depending on the type/brand of headset used.  

 

2.2 Supported Operating Systems 

Phontage can run under any one of several Microsoft Operating Systems including: 

 Microsoft Windows Vista, 7 

 Microsoft Windows 2003 

 Microsoft Windows XP Home 

 Microsoft Windows XP Professional.  

 Microsoft Windows 2000 Professional 
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2.3 System Connection 

A PC running the Phontage application may be connected to the System either as a local or 

remote device.  Connecting as a local device requires Phontage connect to the same LAN as the 

host System.  When connecting as a remote device, the User ID and Password must be pre-

registered in the System database (refer to 2.6.2 for remote operation set up information). 

Figure 2.3 illustrates the connections to the System. 

 

Figure 2.3 Phontage Connections 

 

2.4 Application Installation 

When the Phontage CD-ROM is added to the CD-

ROM drive of the PC, an auto-execute program will 

start and the install Wizard should appear. 

To install the Phontage Application, perform the 

following Steps: 

1. At the InstallSh ield Wizard screen for 

Phontage, click on the Next button. 
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2. Enter the User Name and Organizat ion; this 

informat ion will be stored in the 

Help>About screen of the application as it is 

installed on your PC. 

 

 

 

 

 

3. Click on the appropriate radio button 

to select your Phontage license type. 

NOTE—The Pro version is available 

in Korea only. 

 

 

 

 

 

4. The Destination folder for the 

Phontage application can be 

modified by clicking on the 

Change button (shown).  The 

default directory is recommended; to 

continue click on the Next button. 

 

5. Phontage install wizard will 

complete the Phontage application  

installation. 

 

 

2.5 System Lock-key  

Prior to registration of the Phontage with the host System, the host System will require 

installation of the Phontage software lock-key.  This can be accomplished by the System 

administrator (refer to the System Admin. Manual for detailed instructions). 
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2.6 Login & Registration  

2.6.1 Login 

To start the Phontage application: 

1. Select the Phontage shortcut icon,            , to start the Phontage application and display the Login 

window. 

 

2. In the Login screen, enter User ID  

and Password, and check any of the 

option boxes to automate login  and/or 

enter a desired Station number which  

the system will use for you if the 

number is availab le (not supported on 

ipLDK System). 

 

3. In addition to Login  in formation, the Login screen can be used to access  the Network Setting 

screen for defining the device environment (refer to the following Section 2.6.2). 

 

2.6.2 Network & Profile Setting 

Network Settings, accessed via the Login screen, define the 

Profile Name, Connection Mode (Local or Remote), and the IP 

address of the host system.  To modify Network Settings: 

1. Select Network from the Login window. 

2. Select Local or Remote mode. 

3. Enter the System IP address for remote connection. 

In Local mode, if the System IP Address is blank, Phontage 

will use multi-cast discovery messages to locate a host. 

 

Defined Profiles can be selected from the drop-down list or 

added/edited/deleted with the Profile Name Tool icons: 

1. Select Profile Name. 

2. Click on the Add or Edit icon in the Network Setting 

screen. 

3. Enter the User ID, Password, and Connection mode. 

4. Enter the IP address of the host. 

5. Select OK. 
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2.6.3 Registration Process 

Auto registration (iPECS System Only) 

When the Phontage application is run for the first time, it will attempt to register to the iPECS 

System with the User ‘s ID and Password.  When locally connected, the initial registration is 

automatic assuming the system is set to allow registration (refer to the System Installation 

manual for Registration Switch settings).  

Manual registration (All Systems) 

When the Phontage is remotely connected or the System is not set to allow new registrations, the 

Network settings must be changed from the Login screen.  The connection mode (Remote) and 

the System IP address must be entered (refer to Section 2.6.2).  In addition, the User ID and 

Password must be registered with the system in the Station User Login program. 

 

2.7 Connection Helper 

Connection Helper screen will be shown when the selected Network Adapter IP address is empty 

(0.0.0.0). Connection Helper allows the User to enter another NIC to login properly. 
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3 Phontage Overview 

 The Phontage Main screen is shown below.  The Main screen is divided into several elements to 

provide a simple and effective User interface.  Each element is briefly discussed in this section, and 

discussed in more detail in subsequent sections. 

 

3.1 Application Menu bar 

The Application Menu bar includes File administration, View screen selection, Tools access and Help 

access menus. 

3.2 Quick Call Menu bar 

Using these menu selections the user can place a call by pre-dialing a number with a mouse in the 

Simple Dial-pad pop-up, selecting a party from the Smart Recent Call list or the Simple Favorites 

list or using the PC keyboard to enter a number or Phonebook name. 

3.3 Simple Favorites List 

The User can populate the Simple Favorites list with commonly used names and numbers.  Using 

the PC mouse to select a list item and the handset icon will place a call. 

3.4 Info & Video Console 

Icons at the top of the Info & Video Console maintain a count of Voice Messages and SMS 

messages not heard or read, as well as a count of missed calls.  The icons may be used to quickly 

access the Message Lists screen. 

The Console displays either the time of day or a monthly Calendar, which will show appointment 
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dates in bold ink.  The Calendar links to Outlook scheduler allowing appointments to be added or 

modified from Phontage. 

The Record button can be used to record a conversation and store the recording on the local PC 

hard drive.  The recording can be reviewed, sent as an E-mail attachment with a commentary or 

deleted.  

The Phontage supports Video communications with an automatic link to a standard PC camera.  

Activate the video camera using the Video button for a preview, then open the channel to send real-

time video to the remote party.  As an additional convenience to business Users,  files may be 

shared in a collaborative multi-party conference session; each party has access to and can edit the 

application file over the Phontage link.  Select the Application Sharing icon, then select from the 

open file list.  The file is opened and displayed to all parties.  Any of the parties may manipulate the 

contents in real- time with the Handover function.  

NOTE—Application Sharing is only available on the iPECS System. 

 

3.5 Basic Call Control Menu bar 

The Basic Call Control Menu bar includes separate slide volume controls for the speaker and 

microphone as well as Transfer, Conference, Hold and Speaker buttons.  In addition, on the far left 

the Text Message button will access SMS and IM screens. 

NOTE—IM Window is only available on the iPECS System. 

 

3.6 Window View Icon Menu bar 

The Phontage Window View Icon Menu bar opens the various Phontage optional windows such as 

the Phonebook, Call Log, Schedule Dial, IP Phone, Flex button, etc.  The Phonebook screen 

displays information on contacts registered in the Contact Manger database.  The fully-searchable 

and sortable Phonebook can be used to place calls and send e-mails.  The Phonebook database can 

be imported from and synchronized with an external source database each time the Phontage 

application is opened.  Also, modifications made to the Phonebook database can be automatically 

exported to the external database to maintain synchronization.  

The Call Log screen maintains a database with a record of each call placed or received by the 

Phontage.  The Call Log, if enabled, can be viewed, sorted and printed or it can be disabled so no 

log records are generated. 

The Recorded Call List screen gives access to tools allowing the User to manage calls previously 

recorded.  Recordings can be played, sent as an E-Mail attachment, deleted, etc. 
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In the Scheduled Dial screen the User can input a Phone number and a Date & Time to call the 

number; at the scheduled time the system will confirm and place the requested call. 

The IP Phone and Flex Button screens allow the User to interface with iPECS in the simple and 

convenient operation of a traditional LG-Ericsson IP Phone. 
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Simple 
Favorites List 

4 Quick Call Menu bar 

 

 

 

 

 

4.1 Placing a Call 

Placing a call with the Quick Call Menu is quick and efficient.  For your convenience, a number of 

calling options are available. 

To place a call: 

Simple Dial-pad pop-up 

1. Click the Dial-pad icon to open the Simple Dial-pad 

pop-up. 

2. Use the mouse to click and enter digits in the pre-dial 

box. 

3. Click on the Call button to initiate the call. 

 

Smart Recent Call list 

1. Click the drop-down list arrow of the 

pre-dial box to view the Smart Recent 

Call list. 

2. Select the desired entry. 

3. Click on the Call button to initiate the 

call. 

 

Simple Favorites list 

1. Double-click an entry in the Simple Favorites list to in itiate a  

call. 

 

 

 

 

 

Simple Dial-pad 
pop-up control 

Drop-down arrow 
in Pre-dial box 
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PC Keyboard dialing 

1. Use the PC keyboard to enter digits or type a name 

listed in  the Phontage Phonebook; entries will appear 

in the pre-dial box as entered. 

2. Click on the Call button (shown) to initiate the call. 

 

Phonebook or Call Log screens 

1. Calls can be placed directly from the Phonebook or Call Log screens by selecting a list entry. 

2. Click on the Call button. 

 

IP Phone screen 

1. Opening the IP Phone screen also will permit placing calls as with any Call Servers terminal. 

 

From Other Applications 

Calls can be placed from other applications while the Phontage is active or minimized.  To place a 

call from another application: 

1. Copy the desired digit string (Ctrl + C) 

2. Press the ―Ctrl + Sh ift + D‖. 

 

4.1.1 Terminate Calls 

To terminate a call: 

1. Select the Telephone icon from the Basic Call Control Menu bar. 

 

4.2 Receiving a Call 

When a call is received, the phone will ‗ring‘ and the selected Caller Information pop-up screen 

will display (refer to Section 5.1.2.7). The screen will show the Caller ID delivered from the 

System and the name referenced from the Phonebook database.  If Phontage is minimized, the 

Caller Information screen will pop-up to display the incoming call information or the Phontage 

icon in the Windows tray will flash to indicate the new call (in this case, Phontage must be 

opened to answer the call). 
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To answer a call with Phontage active: 

1. Click on the Telephone icon from the Basic Call 

Control Menu bar. 

 

To answer a call with Phontage minimized: 

1. Click on the Telephone or Phontage icon from the Caller Information pop-up screen (press the 

Enter key or Space Bar as a short-cut). 

 

 

 

 

 

To terminate a call: 

1. Click on the Telephone icon from the Basic Call 

Control Menu bar (press the Enter key or Space Bar 

as a short-cut). 

 

 

4.3 Enblock Dialing 

Phontage supports Enblock Dialing. So, a dialing number is quicker than overlapping dial. 

 

NOTE—iPECS LIK P5, CM or MG  is needed for this feature. 
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5 Application Menu bar 

 

 

 

5.1 File 

Selecting File from the Application Menu bar will display the File menu 

selections. 

 

 

 

 

5.1.1 Logout 

The Logout item will terminate the User 

connection to Phontage and will display the 

Login screen.  Closing the Login screen will 

then terminate the Phontage application. 

Checking the Desired Number box will allow 

entry of a preferred station number (if 

available) for your Phontage. 

NOTE—Desired Number is only available on the iPECS LIK system. 

5.1.2 Setting 

The Setting item will display a sub-menu where the User can determine the Connection Mode, 

Language, Dialing rules, Ring tone, etc. 

NOTE—The ipLDK system only supports the Remote 

Connection mode. 
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5.1.2.1 System Connection 

The Phontage can be registered to a System in Local or Remote Mode.  In the Remote Mode, 

Systems will allocate a VoIP channel to support the call.  The VoIP channel will implement 

Network Address & Port Translation (NAPT) 

compatibility and packet forwarding to internal 

appliances. 

Selecting System Connection will display the 

System Connection screen with the present mode 

checked (Local or Remote).  When either mode is 

selected, the Phontage will terminate and re-connect 

with the host System to establish the selected 

connection mode.  Also in this screen, the host 

System IP address and a Network Adapter Ethernet 

MAC address can be entered or selected.  

 

5.1.2.2 Password Change 

Selecting Password Change will display the Change 

Password screen.   To change the password: 

1. Type in the correct Current Password. 

2. Type in the desired New Password. 

3. Type in the desired new password again in the 

Confirm New Password box. 

4. Click on OK to save changes. 

NOTE—iPECS system only. 

 

5.1.2.3 IP Bridge Mode 

IP Bridge Mode can be enabled under the File – 

Setting menu (shown) for when the Phontage is 

linked with IP Phone. After dialing a number with 

Phontage and then lifting IP Phone Receiver, the 

voice path will be changed to IP Phone Receiver 

automatically.  

 

NOTE— iPECS LIK P5, CM or MG is needed for this feature. 
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5.1.2.4 Preference Codec Selection 

Phontage now supports G.711, G.723 and 

G.729 with iPECS LIK P5, CM or MG 

System. With Phontage, the User can 

select a preference codec: 

1. From the File menu, select 

Setting>Preference Codec. 

2. Select the applicable codec to be 

applied to the System Web Admin. 

(verify using PGM 132). 

 

 

5.1.2.5 Language 

Phontage supports multiple languages, English is the default and a Local Language can be 

designated.  The Local Language is translated from English and edited into the 

‗language.txt‘ file located in the Phontage program directory.  For additional help, access the 

‗language.txt‘ text file in the Phontage folder. 

Selecting Language will display the English/Local Language selection box with the present 

mode checked. When selecting the desired language, the Phontage will automatically change 

all text and messages to the desired language. 

 

5.1.2.6 Dialing Rules 

When placing an outside call from the Phonebook or Call Log screen, Phontage must 

include or remove certain dial codes to assure proper dialing through the System. When a 

number is selected from either screen, the system will 

compare the number to the dialing rules codes.  The 

dialing rules country and area codes are compared to 

the number and if matched are deleted from the 

number.  If not matched, the appropriate LD or 

International codes are inserted (preceded by the PBX 

and CO or IP line access codes).  Codes are entered in 

the Dialing Rules dialog box, along with local codes 

for comparison. 

 

To enter Dialing Rules codes: 

1. Select Dialing Rules from Setting sub-menu. 
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2. Enter the appropriate codes. 

3. Click on the OK button. 

NOTE—For proper operation, Phonebook entries should follow normal conventions.  

Ex., 

―+country code (area code) number‖ [+82 (031) 450-4636] 

 

5.1.2.7 Popup & Outlook 

When an incoming call is received, Phontage will provide one of several Caller ID pop-up 

screens.  In addition, the pop-up can be displayed for an outgoing call.  The selection of a 

pop-up and when a pop-up is displayed is assigned in the Popup & Outlook screen. 

NOTE—The ―Multi-call‖ type pop-up provides added information for DID Call types. 

To define Pop-up use: 

1. Select Popup & Outlook from the Setting sub-

menu. 

2. Select the desired Pop-up; popup selections include 

Phontage Simple, Graphic and Multi-Call or 

the Outlook Contact screen (shown). 

 

 

 

 

 

3. Select the desired Pop-up Timing. 

4. Select OK. 

 

 

 

 

The Outlook pop-up is normally 

employed for external calls but can also be used for internal calls by selecting Internal Call in 

the Popup & Outlook screen. 

NOTE—Outlook contacts must include Internal Users to display the proper contact 

information. 
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5.1.2.8 Call Log (On/Off) 

Phontage can maintain a list of all 

calls to the phone.  Selecting Call Log 

from the Setting sub-menu, will 

display the On/Off selection box with 

the present mode checked. When 

enabled, the Call Log is available for 

viewing and use. 

 

 

 

 

 

5.1.2.9 Differential Ring 

The Phontage comes equipped with 4 ring files for notification of internal and external calls.  

Each ring file is a .wav encoded audio file. The User may select the ring tone from one of 

these files or upload a .wav type file for audible alerting. 

NOTE—Standard .wav or .mp3 files are supported.  Supported .wav files should be 8 or 16 

bit encoding, mono or stereo, at 8.0, 11.025, 22.05 and 44.1 KHz sampling. 

 

Selecting Differential Ring from the Setting sub-menu will open the Bell Sound screen.  To 

change a Ring tone file: 

1. Click on the spyglass icon next to file  to be replaced.  

2. Select the desired .wav or .mp3 file from the PCs file system, and click on the Change button. 

3. Click on the Listen button to hear the selected ring tone. 

4. Click on the OK button to close the Bell Sound. 
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To select a Ring Tone for use: 

1. Open the IP Phone window (refer to Sect ion 9.7). 

2. Click on the PGM fixed feature button. 

3. Dial 1 for Ring Tone Selection. 

4. Dial 1 for Intercom Ring, or 2 for CO/IP ring. 

5. Dial the desired Ring Tone (1-4); a  short burst of the tone will be heard. 

6. Click on the SAVE button. 

NOTE—ipLDK supports Ring 1 only 

 

5.1.2.10 Audio Control 

Phontage can control the sound device employed.  

Select a Speaker for playing back Ring/DTMF and 

select a Speaker and a Microphone for 

communication. The Speaker can be defined 

separately for voice and ring signals. Selecting the 

Audio device drop-down menu will display the 

device choices available. 

 

 

 

 

5.1.2.11 Hook Switch Setting 

Hook Switch Setting provides remote-hook 

for answering or dropping a call using one of 

several Headsets. The supported Headsets 

include: 

1. Audio 910 Headset 

2. CS 50/60 USB Headset 

3. GN8120 Headset 

 

Headsets have different remote-hook switch 

and functions. To use one of the listed 

headsets with Phontage, refer to the Manual 

packaged with the headset. 
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To enable the remote hook switch: 

1. Select the Headset plugged in to the PC. 

2. Click on the Enable the remote hook switch checkbox. 

3. Click on OK. 

 

Place a Call (CS 50/60 USB Only): 

1. Press Long Volume Up to dial fo r ‗Assigned Number.‘ 

2. Press Long Volume Down to dial for ‗Assigned Number.‘ 

NOTE—Refer to the manual CS50/60 USB Headset manual.  

 

Receiving a Call: 

1. Press ‗Remote Hook Switch‘ on Selected Device. 

Drop a Call 

1. Press ‗Remote Hook Switch‘ on Selected Device. 

 

5.1.3 Stay On Top 

The Stay On Top selection from the Settings sub-menu designates that the Phontage Main 

window should remain viewable regardless of if other applications are in use. 

5.1.4 Transparent Window 

The Phontage Main Window can be made transparent, allowing you to view other active 

applications while Phontage is on top. The Transparent Window can be set at one of four 

transparency levels, High, Middle, Low or none (Restore). 

5.1.5 Go To Tray 

The Go To Tray item of the Setting sub-menu will minimize the Phontage application and send it 

to the System tray. 

5.1.6 Exit 

The Exit item will terminate and close the Phontage application. 
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5.2 View 

The View menu allows access to the Phontage optional 

windows and controls display of the Window View Icon 

Menu bar.  Optional windows available are (refer to 

Section 9 for more detailed information): 

 Phonebook 

 Call Log 

 Recorded Call List 

 Schedule Dial 

 Conference Room 

 IP Phone 

 Flex Button 

 

The last item in the View menu (View Toolbar) controls the display of the Window View Icon Menu 

bar.  Checking the View Toolbar enables display of the Icon Menu bar at the bottom of the 

Phontage Main Window. 

 

5.3 Tools Menu 

From the Tools menu you manage the 

Phonebook, Short-cut keys and Call 

Forward settings.  In addition, Recording, 

Video-cam Calls and Application sharing 

functions can be activated in the Tools menu.  

 

 

 

 

 

 

5.3.1 Phonebook Management 

Selecting Phonebook Management item from the Tools menu will present the Phonebook menu 

for to opening a new or existing database, saving a database, importing or exporting a database 

or maintaining synchronization with an external database.  Using the Phonebook is described in 

more detail in Section 9.1. 
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The User may open a new blank database for use with the Phonebook window. 

1. Select New from the Phonebook Management menu.  

2. Select a folder location. 

3. Enter a filename. 

4. Click on the OK button to save. 

 

The User can select the database used with the Phonebook window.  Once selected, the database 

is used for Phontage Phonebook until a new selection is made by the User.  To open a selected 

database: 

1. Click on Open from the Phonebook Management menu. 

2. Select a database; the file  format  of the database must be consistent with the *.cds file fo rmat of 

the Phontage database. If a d ifferent file  type is selected, a warning message will be returned. 

 

Various contact manager applications employ different data formats.  To permit use of common 

formats, Phontage allows you to import databases from Outlook, GoldMine, ACT! or Excel 

applications.  When imported, the database format is modified to match the Phonebook database 

and displayed in the Phonebook window.  To import a database: 

1. Select Import from the Phonebook menu. 

2. Select the applicat ion type (Outlook, Gold Mine, ACT! or Excel). 

3. Select the database. 

 

It may be a good idea to save a copy of the Phonebook database as a back-up copy or for future 

use.  To save a copy of a database: 

1. From the Phonebook menu, select Save As. 

2. Select a folder, if different than the Phontage folder. 

3. Select the filename. 

4. Click on the Save button. 

 

The Phonebook database can be exported for use in other applications including Outlook, Gold 

Mine, and ACT! or Excel.  To export a Phonebook database: 

1. From the Phonebook menu, select Export. 

2. Select the applicat ion type (Outlook, Gold Mine, ACT! or Excel). 

3. Select the database. 
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The Phonebook can be synchronized with an external Outlook, Gold Mine or ACT! database 

automatically.  Each time the Phontage is started it will use the external database as the 

Phonebook for synchronization (auto importing).  

To enable automatic synchronization,  

1. Select Sync Database from the Phonebook menu. 

2. Select the applicat ion type to import.  

3. Select the database. 

NOTE—Phontage must be (re)launched to synchronize any changes made directly to an 

external database.  Also, during import or export of an Excel file, the file may need to be closed 

manually. 

 

5.3.2 Short Cut Management 

While Phontage is active, Short Cut or Hotkeys can be used 

for quick access to functions within the application as shown 

in the Hotkey Setting screen.  Hotkey settings can be modified 

to meet your needs. 

To modify the Hotkey assignments: 

1. Select the desired Hotkey. 

2. Enter the desired Hotkey keyboard combination. 

3. Click on the add icon, , to confirm and store the new 

combination. 

 

5.3.3 Call Assistant 

The Call Assistant bar is quick way to place and receive calls.  The bar is similar to the Quick 

Call Menu bar and is always displayed on-top of the Windows desktop to minimize interference 

with the display (ex., active applications, etc.).  The bar may be dragged and dropped to any 

location on the User PC desktop. 

 

 

The Contact List in the Call Assistant bar will display the User Phonebook and Favorites List for 

quick dialing, or the User can dial from the 

desktop numeric keyboard.  The Call Assistant 

bar also can be displayed with a small version of 

the IP Phone LCD. 

Drop-down arrow 
in Contact List 
window. 
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To place a call from the Call Assistant bar: 

1. Click on the the drop-down arrow to display the Contact List.  

2. Double click on the desired entry, 

OR 

3. Click in the Call Assistant 

window. 

4. Dial with the desktop numeric keys. 

5. Click Call. 

 

To add the IP Phone LCD to the Call Assistant bar: 

1. Right-click on the Call Assistant bar. 

2. Select Display LCD from the menu.  

 

5.3.4 Favorite Contact Dialer 

The Favorite Contact Dialer is always displayed on-top of other 

desktop screens, is populated from the Favorite Contacts List in the 

Info and Video Console.  Selecting a name from the Dialer will 

place a call to the User.  The Dialer is semi-transparent and may be 

dragged and dropped to an unobtrusive location on the User PC 

desktop. 

 

5.3.5 Voice Record 

Phontage uses the PC hard drive to record an active call.  Recording a call is controlled using 

the Voice Record item in the Tools menu (Ctrl-Alt-R Short-cut keys), or the Record button in 

the Info & Video Console (refer to Section 6.5). 

 

5.3.6 Video Display 

Phontage uses your PC camera to send real-time video communications over an IP-based 

network.  Video calls can be established using the Video Display item in the Tools menu (Ctrl-

Alt-V Short-cut keys), or the Video button in the Info & Video Console (refer to Section 6.6). 

 

5.3.7 Application Sharing 

Phontage users can share file applications over an TCP connection.  File sharing can be initiated 

with the Application Sharing item in the Tools menu (Ctrl-Alt-S Short-cut keys) or the Sharing 

button in the Info & Video Console (refer to Section 6.7). 
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5.3.8 Call Forward 

Incoming calls can be re-routed to other Stations (Internal Stations, Network Stations), Station 

groups, System Voicemail, or over CO/IP resources. 

NOTE—The Call Forward screen is supported by the iPECS system; other systems can support 

the Forward function using a flex button and the IP Phone screen. The way of setting Call 

Forward depends on System type. This is the way of iPECS LIK system. For other system, refer 

to those manuals. 

To activate Call Forward, Unconditional or Busy/No 

Answer: 

1. From the Tools menu select Forward to display 

the Forward screen. 

2. Select the desired Call Forward type (Unconditional, 

No Answer, Busy, or Busy No Answer). 

3. Enter the Password (if applicable). 

4. Enter the Station, Hunt Group or Speed Dial number 

where calls will be sent. 

5. Click on the OK button. 

 

To activate Call Forward, Off Premise (to an external 

number): 

1. In the Forward screen, click on the SPEED checkbox. 

2. Select desired Call Forward type. 

3. Enter desired forwarding location. 

4. Click on OK. 

 

To activate Call Forward, Remote (Follow-me): 

1. In the Forward screen, click on the REMOTE checkbox. 

2. Select desired Call Forward type. 

3. Enter the Station Authorizat ion Code (Password). 

4. Enter the Station, Hunt Group or Speed Dial number where calls will be sent. 

5. Click on the OK button. 

 

To deactivate Call Forward: 

1. In the Forward screen, select Clear as the Forward type. 

2. Click on OK. 
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5.3.9 E-Mail 

The Phontage can be used to access the Outlook Email application to send Emails.  Selecting 

Email from the Tools menu will launch the Outlook Email application.  The Email application 

can also be launched from the Phonebook screen (refer to Section 9.1). 

 

5.3.10 Fixed Line SMS 

The Fixed Line SMS board should be installed for the 

User to send and receive Fixed Line SMS. 

Fixed Line SMS should be enabled by System 

Administer of System. This feature can be accessed by 

menu under Tools- Fixed Line SMS or Fixed Line SMS 

Popup menu in Phonebook address. 

NOTE—iPECS CM and MG support Fixed Line SMS 

on Internal SMS window but not separated this Window.  

 

The Fixed Line SMS screen Send tab is for sending a 

Fixed Line SMS to an external Number. 

 

To Send SMS messages: 

1. Enter the appropriate Sender Number. 

2. Enter the Target Number. 

3. Click on the Add Button . 

4. Enter the desired Message. 

5. Click on the Send button. 

 

 

 

 

 

 

When a new Fixed Line SMS is received, the SMS icon will illuminate and show the number of 

message(s). The message number is a sum of Internal SMS and Fixed Line SMS. 

 

 



ECS                 Phontage Desk-top Installer & User Guide 

 

 5-14 iss. 3.0 

 

 

If there is a Fixed Line SMS, the Receive Tab will be shown, and the following information will 

be displayed: 

 Date & Time 

 Sender Name 

 Sender Phone Number 

 Message Arrived 

 

To Reply to SMS messages: 

1. Click on the Reply icon. 

2. The Send Tab will be shown and the 

Sender Number will automatically be 

added in the Target Number box. 

3. Click on the Add button . 

4. Enter the desired Message. 

5. Click on the Send button. 

 

5.3.11 LDAP Search 

When LDAP Server is available to connect, Phontage User can use the LDAP Search Service 

with a Keyword. The keyword should be a Name, Company or Department. 

 

5.3.11.1 Setting 

To use LDAP Search, the following should first 

be designated on the Setting screen: 

NOTE—LDAP Server Administer should inform 

following values. 

 Server Name or IP Address 

 Search Base 

 Login Informat ion 

 Login is necessary or not 

 If Necessary, ID and Password 

 User SSL 

 SSL is supported or not 

 LDAP Port (Default=389) 
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5.3.11.2 Search 

The Search Tab consists of: 

 Input Keyword Box 

 Matched Number 

 Brief list of matched result  

 Detail Information Display 

 Dial Button 

 

To search a record: 

1. Input Keyword (Name, Company or Department). 

2. Click on the spyglass icon (Search button). 

 

To place a call 

1. Click on the Call button. 

 

5.3.12 Audio Tuning Wizard 

The Audio Tuning Wizard helps the Phontage User to control the Sound device easily. 

NOTE— iPECS LIK P5, CM or MG is needed for this feature. 

 

The Intro Window explains what the Audio Tuning Wizard 

is. 

As the screen reads, it: 

“…optimizes the volume level of speaker and 

microphone for your conversation. The speaker is a 

device for listening counterpart's voice. The 

microphone is a device for sending your voice to 

counterpart.” 
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The User can select a preference for Speaker and 

Microphone Devices, such as: 

 Sound Device for Ring/DTMF 

 Speaker 

 Sound Device for Communication 

 Speaker 

 Microphone 

 

 

The Speaker Volume for Ring screen can assist the 

User in adjusting the speaker volume to a 

comfortable level. If the volume is higher than 

necessary, the User may be troubled by the high 

sound when a Ring/DTMF is generated. 

This window should play a ring sound allowing the 

User to appropriately adjust the sound level. 

If the Speaker‘s setting is not suitable for generating 

a Ring/DTMF, the wizard will try to correct the 

problem.  If the problem is not corrected, verify the 

following are working to remedy the situation.  

 Mute Status 

 Zero Volume Status 

 Unplugged Jack Status 

 

The Communication Volume Control screen assists 

the User in adjusting the speaker volume to 

comfortable level. If the volume is louder than 

necessary, echo may result when user is in a 

conversation. 

The Volume gain will be shown visually. 

Microphone Volume will be controlled by the 

Phontage. (User is not able to change microphone volume). 
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The Auto Enable screen is used to set up options 

relating to sound while on a conversation. 

 

 

 

 

 

 

 

 

User can run this Wizard again in the feature form 

Audio Tuning Wizard under Tool menu. 

 

 

 

 

 

 

 

 

5.4 Help Menu 

5.4.1 Help (F1) 

The Help item from the help menu launches PDF help file named 

‗Phontage_UG.pdf‘. This file should be placed in the installed program 

directory and also Adobe Reader should be installed on your PC. 

 

5.4.2 About 

The About item from the Help menu displays the version for the Phontage. 
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6 Info & Video Console 

 

6.1 Logout 

The Logout button, located in the upper-left area of the console, will logs the current User out of 

the Phontage application and return the Login screen. 

 

6.2 Message Icons 

At the top-right of the Console are the Voice Message, SMS message and Missed Call icons.  Next 

to each is a counter for each icon.  The icons access the Message Lists screen with a view of 

messages in the selected list (Voice Mail, 

SMS, and Missed Call).  Messages can 

be played or read and managed from the 

toolbar.  Messages can be deleted, or 

returned using SMS or placing a call. 

When assigned in the iPECS system, the 

Phontage may receive notification for 

other users as a back-up station (refer to 

Section 10.2). 

NOTE—Phontage running on an iPECS 

LIK System can save up to 10 messages 

for viewing; to receive more message from the system, read system messages by clicking on the 

SMS Icon or click on the Refresh button in the SMS screen. 
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6.3 Clock-Calendar View 

The Clock and Calendar icons control the Console showing the current time or a monthly calendar 

with links to Outlook (refer to Section 6.4).  

 

 

6.4 Appointment Calendar 

Phontage Calendar displays a monthly calendar with the current date in green and any date with 

appointments in bold text.  By right clicking the mouse over a date on the calendar, an 

Appointment Summary is displayed over the Schedule window. Today‘s schedule will be scrolled 

in the Info & Video Consol Window. 

 

The Phontage Calendar display permits on-screen 

access to the Outlook Scheduler in two ways: 

1. Double click on a date in the Calendar d isplay, 

OR 

2. Right-click the mouse over the calendar date. 

3. In the Summary window, double-click an 

appointment. 

 

 

Phontage will launch the Outlook 

Scheduler. To add or modify an 

appointment in the Scheduler edit 

screen: 

1. Enter a new appointment, o r 

edit an existing item 

following the Outlook 

instructions. 

2. When finished, click on the 

Save and Close button; the 

Appointment  will be saved in 

Outlook and will be updated 

in the Phontage database. 

 

 

Clock/Calendar 
icons 
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6.5 Call Recording 

A recording can be initiated using the Record button, which will illuminate to indicate recording 

in progress. Phontage uses the PC hard drive to record an active call.  The recorded files are then 

managed in the Recorded Calls list accessed from the View menu or directly from the Recorded 

Calls list button in the Window View Icon Menu (refer to Section 9.3). 

 

6.6 Video Calls 

Phontage uses your PC camera to send real-time video communications over an IP-based 

network. The real-time video supports transport of H.263 standard video codecs.  The frame rate 

may be increased to 15-frames/second but packet loss and delay may become excessive and 

lower frame rates may perform better with other services.  When a video call is placed, an IM 

chat channel is opened and can be accessed via the Text Message screen (refer to Section 8.3.2). 

To initiate a Video call: 

1. Place a call to another Phontage User. 

2. Select Video for a preview of the Video-

cam output. 

3. Click on Send to transmit the Video. 

 

To receive a Video call: 

1. When a call is received from another Phontage User, select Video for a preview of the Video-cam 

output. 

2. Click on Send to transmit the Video. 

 

To mute (turn-off) Video transmission: 

1. Right-click on your v ideo 

image. 

2. Select Stop from the pop-up 

menu. 
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To enlarge the received video window: 

1. Double or right-click on  the receive 

window. 

2. Select Video Large Display from 

the pop-up menu. 

 

 

 

6.7 Application Sharing 

Phontage users can share file applications over the TCP connection.  Any active or minimized file 

can be viewed and manipulated by all parties.  Control over the file and application can be shared 

for a collaborative session using presentations, drawings, documents, etc.  

The Sharing button will display the Sharing Master screen.  Only active or minimized files can be 

accessed by the Phontage sharing application.  

To share an application file: 

1. Click on the Sharing button. 

2. Select the file  from the Sharing Master 

screen Application drop-down list. 

3. Click on the Start button to begin the 

sharing session. 

 

 

 

 

 

 

 

 

 

 

 

 

The Sharing Remote window includes a Menu bar at the top.  When a User is given control, the 
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file title turns to a red color.  The connected party may be allowed control for input and locally-

storing the file.  To shift the controlling user: 

1. From the Sharing Master screen, click on the Handover icon. 

2. Select the desired User by clicking on the adjacent radio button; the title in the upper menu bar will 

turn to a red color. 

 

Files are automatically sent from the Controller (Master User‘s Phontage) to the other party 

periodically.  The interval is from 1 to 10.0 seconds, 5 seconds is generally acceptable for most 

collaborative work while longer periods are acceptable for reviews. 

To adjust the interval: 

1. From the Sharing Master screen, click on the Frame Interval from the drop-down menu. 

2. Select the desired interval.  
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7 Simple Favorites & Connected Lists 

7.1 Simple Favorites Contact List 

The Simple Favorites list is a list of commonly or recently used names and 

corresponding numbers too simplify dialing. 

The Simple Favorites list is used by: 

1. Selecting an item from the list. 

2. Click on the Phone icon to place the call. 

 

From Favorite Contact window, a name or number can be added, modified or deleted. 

To add or modify the Simple Favorite list: 

1. Select a contact from the list.  

2. Click on the Add (+) icon. 

3. Enter the Display Name and Phone 

Number. 

4. Click OK. 

 

7.2 Connected Parties List 

While on a call, the Connected Parties list is displayed in place of the Simple 

Favorites list.  The Connected Parties list shows the external and internal 

parties in the current conversation. 

NOTE—In the ipLDK System, only the conference initiator will see other 

parties in a conference. 
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8 Basic Call Control Menu bar 

 

 

 

 

8.1 Volume Controls 

Separate slide controls are provided for adjusting the Speaker level. Use the mouse to drag the 

slide control right to increase volume, or drag left to decrease volume. Microphone volume level 

is adjusted automatically. 

8.2 Call Handling Buttons 

On the Basic Call Control Menu bar are buttons for quick access to common call handling features.  

The available buttons are: 

 Transfer – Used to initiates a call transfer. 

 Conference – Used to initiate and set-up a conference call.  

 Hold – Used to place an active call on Hold. 

 Speaker – Used to answer and terminate calls. 

 

8.3 SMS & IM Window 

8.3.1 SMS Window 

Short Message Service (SMS), which is typically provided in GSM mobile networks, is a service 

that allows you to send and receive text messages with other users.  A text message is comprised 

of an alphanumeric combination of up to 100 characters.  An SMS can be sent employing the 

Text Message window or as a reply to a received message (refer to Section 6.2). The Phontage 

maintains up to ten received messages after which, new messages are ignored.  

To send a text message to other 

Users: 

1. Click on the Text 

Message button; if 

needed, select the 

SMS tab to show the 

SMS screen. 

2. Enter the desired text  

message. 

Text Message 
Window  access 
button 
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Text Message Window 
access button 

3. Click on the Send button in the SMS window; the Member window will appear. 

4. Select the desired recip ients by clicking on the check boxes. 

5. Click Send to deliver the message. 

NOTE—Station Lists window is for only iPECS LIK system. And Fixed Line SMS can also be 

sent by this window for iPECS CM and MG. 

 

8.3.2 IM Window 

The IM window sends and receives an instant messaging dialogue between the parties connected 

in a Video-cam call.  In the IM window you may initiate or interact in an IM dialogue with other 

internal users connected during an active call.  

To use the window: 

1. Select the Text Message button; if needed, select the IM tab to show the IM window. 

2. Type message and select SEND. 

 

To adjust fonts: 

1. Click on the Character icon (bottom left), and select the desired font characteristics. 

NOTE—Only available on the iPECS LIK P5, CM or MG system. 
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9 Window View Icon Menu bar  

The Window View Icon Menu bar gives quick access to the various optional windows of the 

Phontage application. 

 

Optional windows include: 

 Phonebook 

 Call Log 

 Recorded Calls 

 Schedule Dial 

 Conference Room 

 IP Phone 

 Flex Buttons 

Only one of the database windows (Phonebook, Call Log, Recorded Calls, Schedule Dial and 

Conference Room) can be opened at a time.  One database, the IP Phone window and Flex Button 

window can be opened simultaneously.  Most window sizes are adjustable (except IP Phone 

window). 

 

9.1 Phonebook Window 

Phontage maintains a Phonebook database of your contacts; other Users and external Contacts 

may be listed in the Phonebook.  Use the Phonebook to place calls and send Emails to contacts 
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selected from the database. Contacts can be searched, sorted and managed using button on the 

Phonebook Toolbar.  When a record is added, edited or deleted in the Phonebook, Phontage can 

also update (synchronize) with the original source database, such as Outlook (refer to Section 

5.3.1). 

 

To call a number from the Phonebook : 

1. From the Phonebook screen, right-click on 

the desired record (refer to search & sort 

instructions). 

2. Select the desired function from the drop-

down menu, 

OR 

3. Select the desired record. 

4. Click the Phone icon in the Phonebook  

Toolbar, 

OR 

5. Double click on the desired  record or 

phone number field. 

 

To send an Email from the database: 

1. Select the desired record(s).  

2. Click on the Email icon from the Phonebook Toolbar, the Outlook Email program will be 

launched and loaded with the selected recipients  in the TO: field. 

3. Enter the subject, message. 

4. Click Send to deliver the email. 

 

To search the Phonebook database: 

1. Enter an alpha-numeric string in the search box 

(Contact name, Number, etc.) 

 

To sort records in the Phonebook: 

1. Click on the header field at the top of the 

Phonebook to sort alphabetically/numerically, 

depending on the information contained in that 

column. 

2. Click again to sort in the reverse order, or click a different column to sort by that information.  
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To add or edit a record: 

1. Select the desired record to be edited. 

2. Click on the Add or Edit icon to view the Contact Record form.  

3. Enter the appropriate informat ion (Name is a required field). 

4. To remove an image from the contact record, right-click on the image to view the Clear Image 

pop-up dialog box; select Clear Image and click OK. 

5. Click on OK to save the record in the Phonebook and synchronize with the source database. 

 

To delete a record: 

1. Click on the desired record(s) to delete. 

2. Click the Delete icon in the Phonebook Toolbar.  

 

9.2 Call Log Window 

The Call Log window is a log of all calls placed or received by the Phontage.  If Call Log is 

enabled under the File>Setting menu, each call (initiated or received) will generate a record. The 

Call Log record contains information on the call as well as data derived from the Phonebook.  

Once the call is terminated, a record is stored in the Call Log database.  The record may contain 

the following fields: 

 Date & Time – Date and 

Time of the call according 

to the User‘s PC. 

 Name – Name of 

connected party according 

to the Phonebook (if 

applicable). 

 Phone – The Called or 

Calling party phone 

number, from the System 

or carrier. 

 Call Type – Type of Call icon, Incoming/Outgoing and Answer/No Answer 

 Duration: duration the call was connected or ringing in hours, minutes and seconds  

The Toolbar at the top of the Call Log window, allows the user to place a call and manage the Call 

Log database. 

 



ECS                 Phontage Desk-top Installer & User Guide 

 

 9-4 iss. 3.0 

 

To place a call from the Call Log window: 

1. Double-click on the record to place the call,  

OR 

2. Select a record. 

3. Click the Phone icon, Phontage will p lace a call to the phone number of record.  

 

To copy a record to the Phonebook: 

1. Right-click on the desired record. 

2. Click Add New (Phone Book) . 

 

To delete an entry from the Call Log list: 

1. Select the Delete or Delete All icon to remove the record; the user will be asked to confirm the 

record deletion. 

2. Click OK. 

 

9.3 Recorded Call List 

Phontage allows the User to record a conversation onto the PC hard drive.  Recorded 

conversations can be reviewed after recording.  In addition, voice memos can be added to the 

recording and sent via email as attached .wav files.  The folder for recorded files can be changed 

by user with          .  

Recording can be activated from the 

Phontage Tools item in the Application 

Menu bar, from the Info & Video Console 

Record button, using the Voice Mail back-

up feature or automatically.  Phontage 

sends a single ―record-start‖ tone. 

NOTE—Others on the call should be 

notified of your intent to record the call 

prior to recording. 

The Recorded Call List window includes playback controls for playing a selected file.  The User 

may delete a file, record a comment, and/or Email the recording using the Playback window 

controls. Use the right-click pop-up menu, to add some text as a comment for on a selected record. 
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9.4 Scheduled Dial Window 

Scheduled Dialing permits the user to enter a phone 

number for dialing at a later scheduled time.  When 

the scheduled time is reached, the Confirm window 

will appear and must be confirmed by the user 

before dialing will begin, and the user can snooze 

the time. 

The Scheduled Dial screen contains a list of the phone numbers and schedules entered by the User.  

The screen Toolbar allows the User to manage 

Scheduled calls. 

To add or edit a Schedule Dial: 

1. Click the Add or Edit icon on the Schedule 

Dial screen; the Schedule Dialing Manager 

screen will d isplay. 

 

 

2. Enter the Name and Company. 

3. Enter the phone number (required entry).  

4. Click the pull-down Date/Time menu. 

5. Select a date from the calendar and the time 

menu (date & time are required entries). 

6. Click OK to save. 

 

To delete an entry from the Scheduled Dial list: 

1. Select the Delete or Delete All icon to remove the record; the user will be asked to confirm the 

record deletion. 

2. Click OK. 
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9.5 Conference Room Window 

Phontage includes the Conference Room feature where you can set-up or join a scheduled 

Conference.  To set-up a Conference Room: 

1. Select Conference Room from the 

View menu. 

2. Select the Create tab. 

3. Enter an Access Code (if desired). 

4. Press Create button; the Room number 

will be automatically given from the 

system. 

 

To send an Email notification of the Conference: 

1. On the lower part of the Create tab, enter 

a Subject. 

2. Select and enter the Email addresses for the Conference invitees. 

3. Select a Date & Time from the drop-down menu. 

4. Enter the desired message in the Contents box. 

5. Click on the Send To  Email button; Phontage will register the Conference Room and send an 

Email to the listed receivers. 

 

To join a Conference Room: 

1. From the View menu, select Conference 

Room. 

2. Click on the Enter tab. 

3. Enter Room Number and Access 

Code (if applicable). 

4. Click on the Join button; the lower 

box of the screen shows others 

who already are participating in the 

Conference. 

 

NOTE— iPECS LIK and ipLDK100/300/600 support auto creation of Conference Room numbers. 

When using other systems, the room number will need to be entered manually. For all systems, the 

Conference Room number should be entered to remove the room from system.  
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9.5.1 Enhanced Conference Room 

Phontage supports the following Conference Room list 

functions: 

 All Conference Room List Number 

 Each Conference Room Status 

 Created/Vacant 

 Each Conference Room Creator 

 Number/Name 

 The number of Participant 

 

To Create Conference Room: 

1. Click on the     button; the Conference 

Room List screen will be displayed. 

2. Select the appropriate room and press the 

OK button; the Conference Room List 

window will be closed and the selected 

room number will be added to the Room 

No. box. 

3. Click the Create button. 

 

The User can Delete or Join a Conference Room 

using the Conference Room List: 

1. Click on the Room you would like to Join or Delete.  

2. Click on one of the buttons shown below the Conference Room List to perform the desired 

function. 

NOTE— iPECS LIK P5, CM or MG is needed for this feature. 

 

9.6 Dynamic Group Call 

Group Call is used to make a conference group call easily using the Phonebook. To use this feature, 

the MCIM or something of MCIM should be running on the iPECS System. The Group Call feature 

covers the following: 

1. Make a Group Call 

2. Notification of Invitation  for Group Call 

3. Display Window 

NOTE— iPECS LIK P5, CM or MG is needed for this feature. 
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9.6.1 Make a Group Call 

Using the Phonebook, a new Group Call can be 

initiated. 

To place a Group Call: 

1. Select the appropriate records from the 

Phonebook. 

2. Right-click on the selected names and 

select Start Group Call from the pop-up 

menu. 

 

To add new member(s) into a current Group Call: 

1. Select the appropriate records from the Phonebook. 

2. Right-click on the selected names, and select Add New Members to Group from the pop-up menu. 

 

9.6.2 Notification of Invitation for Group Call 

When Phontage is invited to a Group Call, the Notification screen will be displayed as shown. 

Phontage will display the ‗Group Name‘ and Inviter‘s phone number. 

To join the Group Call: 

1. Click on the Yes button. 

2. The Group call will be activated.  

To reject the Group Call: 

1. Click ‗No‘ button. 

2. The Group Call Notification screen will d isappear. 

 

9.6.3 Display Window 

Phontage will display the following information 

for the Group Call after joining the call: 

 Name 

 Phone Number 

 Call Status (Ringing /Busy 

/Connect / Disconnected) 
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To hang-up the call: 

1. Click on the Hang-up Button. 

 

9.7 IP Phone Window 

The IP Phone Window allows complete access to 

all System features as well as the features 

available to traditional LG-Ericsson IP Phones, 

with few exceptions based on the differences in 

the user platform.  The fixed feature keys operate 

in the same manner as the IP phones except the 

mouse is used to select dial pad and feature 

buttons.  For operation of the features, refer to the 

System Quick Guide or the LG-Ericsson IP 

Phone User Guide. 

 

9.8 Flex Button Window 

The Flex Button window provides access to 48 Flex buttons in the screen.  Each button includes a 

status icon, which displays the status of the CO Line or station associated with the button.  The 

button also displays a designation from the System database, such as CO 001, SPD 001, etc.  A 

customized label can be assigned in 

Phontage. 

Selecting a Flex button with the left-mouse 

button will access a CO line, call a Station 

or activate a feature based on the function 

assigned to the Flex Button in the System 

database. 

NOTE—Only iPECS LIK Systems use this 

screen. Other system can do this function 

from the IP Phone screen and Flex Button 

screen. 

 

The System allows access to Station Speed Dial numbers which can easily be programmed to a 

Flex button. 
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To enter and assign a Station Speed Dial to a Flex button: 

1. Right-click the mouse on the Flex button you 

wish to program. 

2. Select Set Attribute; the Flexib le Button 

program screen will display. 

3. Use the pull-down menu to assign the Speed 

Dial b in number (for ipLDK-100, bins 00 to 

19 or for the ipLDK-300, bins 000 to 099). 

4. Enter the number to be dialed.  

5. Enter an optional Description (d isplay) label for the Flex Button. 

6. Click on the Save button. 

NOTE—If a Flex button is assigned for Paging, the Speakerphone must be activated prior to 

selecting the Page button. And the assignment should be done in idle state.  
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10 iPECS System Integration Features 

The iPECS system supports special functionality employing the special characteristics of the 

Phontage PC as a terminal.  The integration of the iPECS system and Phontage PC enables 

enhanced audio file capture and management features including: 

1. Automatic Call Recording, Phontage or 3
rd

 party 

2. Voice Mail Back-up Station 

 

10.1 Automatic Call Recording 

When enabled in the iPECS system, conversations of the Phontage and/or other 3rd party iPECS 

users are recorded to the hard drive of the Phontage PC.  Automatic recording is assigned under 

PGM 112 of the iPECS system.  Other stations in the system may be assigned to record 

conversations to the Phontage, 3rd party recording. 

Recorded conversations are managed from the Recorded Call List (shown), which will indicate the 

Date, Time and Station number(s) that was party to the conversation. 

NOTE—To record 3rd party conversations properly; the Phontage must be idle. 

 

 

 

 

 

 

 

 

10.2 Voice Mail Back-up Station 

When enabled in the iPECS system, the Phontage receives notification of voice mails for other 

3rd party iPECS system users.  Notification from the iPECS VMIM or something of VMIM 

increments the Voice Message count shown in the Info & Video Console (refer to Section 6.2).  

The 3rd party Voice Messages are copied to the Voice Mail Message List where they can be 

managed, and may be deleted by the Phontage user (if available). 
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To back-up and manage Voice Mails from the Voice Mail Message List : 

1. Click the Voice Message icon in the 

Info & Video  Console; the  Voice 

Message List will d isplay. 

2. Select the desired Station from the Station drop-down menu in the Message List screen. 

 

3. Click on the Backup button, the messages will be downloaded to the Phontage PC hard drive. 

4. Use the Message List Tool bar and Audio controls to manage the displayed messages.  For 3
rd

 

party messages, you must be enabled in the iPECS system to delete messages. 

NOTE—A VSF/VMIM or something of VSF/VMIM is required in the host iPECS System. 

REMARK—Voice Mail Back-up is not possible from Phontage in remote Mode or Voice Back-up 

is only possible from Phontage in the local mode. Refer to the System Manual for more 

information. 

 

 



ECS                 Phontage Desk-top Installer & User Guide 

 

 11-1 iss. 3.0 

 

11 Smart Tray Icon & Menu 

When the Phontage application is executed, a tray icon is created.  The icon is displayed in the 

Windows system tray.  The Smart Tray icon will display the status of the connection with the 

System (connected or disconnected), as well as message events (as shown). 

 

Right-click on the icon to open the Smart Tray Menu, which 

includes: 

 Tray Popup Cancel – Select to close the Smart Tray Menu 

 Call Assistance – Select to open the Call Assistance 

Window. 

 Recent Call List – Select an item from the sub-menu to 

initiate a call. 

 Speaker Button – Select to control the speakerphone. 

 Show Main Window – Select to open the Phontage Main Window. 

 Exit – Select to close the Phontage application. 

 

 

Missed call SMS Waiting            New Voice Mail 
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